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Software Activation Procedure 

 

 The 611A Dynamic Muscle Analysis software must be activated before it can be 

used.  Activation allows us to provide you with superior service and product updates.   

  

 To activate the software, you will need your serial number, and product key.  These 

can be found on the foil serial number tag affixed to the PC or to the jewel case containing 

the software DVD.  Below is an example of these.  

 

Serial: 611001 

Product Key: 017C8 

 

 

 Upon starting the software for the first time, you will be presented with the software 

activation window.   

 

1. Enter the Serial number and Product Key. The program will return a 15 character 

activation key, copy or write this down. 

2. On the PC with internet access, point your web browser to: 

http://www.AuroraScientific.com/activate 

3. Enter the Activation Code returned by the program, your contact details and then click 

on the Activate! button.  See Figure 1. 

http://www.aurorascientific.com/activate
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Figure 1 ASI Product Activation Website 

 

4. Copy or write down the 16 character license code returned by the webpage.  The code 

is unique to your computer and cannot be used on another computer. Additional 

licenses must be purchased for use on multiple computers. 

5. Enter the license code back into the activation window to complete the activation 

process. 

6. Once complete, exit and reopen the application. 

7. Repeat as required for additional ASI software.   

 

Should you encounter any issues with this procedure, please contact ASI by phone or email, 

and we will be happy to help you with this process. 
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1.0 Introduction 

 

The 611A Dynamic Muscle Analysis (DMA) software was designed to enable 

physiology researchers to study the dynamic mechanical characteristics of muscle tissue.  

The system is capable of analyzing data from all of our data acquisition products, including 

Dynamic Muscle Control (DMC) and 600A Digital Controller.  

 

DMA has an easy-to-use graphical user interface and is written using the LabVIEW 

programming language.  The software analyzes the data recorded by our data acquisition 

products, and produces muscle data, work loop data, and time derivative data.  Collected data 

can be plotted and analyzed within the program’s many windows.     
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2.0 Specifications 

 

Model: 611A Dynamic Muscle Analysis 
 

Personal Computer Recommended Specifications 
Processor: Quad-Core Intel or AMD. 

RAM:  4 GB. 

Hard Disk:  500+ GB. 

 

Personal Computer Minimum Requirements  
Processor: Dual-Core Intel or AMD. 

RAM: 2 GB. 

Hard Disk: 40 GB. 

 

Operating System 

Type: Windows XP/Vista/7. 

 

ASI611A Software  
Programming Language: LabVIEW 

Interface: GUI, drop down menus. 

Menu Structure:  

File:   Open ASI Data File,  

 Open ASCII Data File  

 Show File Info  

 Exit 

High Throughput: Force-Frequency Analysis 

 Force-Time Analysis 

 Position-Time Analysis 

 Fatigue Analysis 

 About DMA-HT 

Help: Topic 

 About  
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3.0 Quick Start Guide 

 

 This guide will help you get started fast, by explaining how to complete some of the 

most common tasks you’ll need to get the most out of your new Dynamic Muscle Analysis 

software.  

3.1 System Setup 

 

Locate the PC running the 611A software wherever it is convenient. The normal 

criteria for locating a PC should be followed including ensuring adequate ventilation for 

cooling along with protection from water, dust, dirt, vibration and shocks.  Note: If you 

purchased the 611A software with a PC then both the PC and DMA were completely 

configured at our factory; you do not need to install any software.  The 611A software runs 

under Windows, and therefore most Windows compatible software should run without issue 

on the same PC with 611A.  We do not recommend running other software at the same time 

as 611A due to its performance requirements. 

3.2 Turning on the PC and Using the Desktop 

 

Once all components of the system have been connected together in the correct 

manner turn on the PC (power switch is located on the front panel).  Turn on the monitor as 

well.  The PC should go through the normal power on self-tests and then the Windows 

operating system should be loaded.   

 

 If you purchased a 601A Windows PC with your 611A software, you will find the 

following icons on your desktop. 

 

DMCv5.3:  – used to start the Dynamic Muscle Control software  

 

DMAv5.1: – used to start the Dynamic Muscle Analysis software. 

 

Measurement & Automation: – used to open the Measurement & Automation Explorer tool 

from NI.  This allows you to verify correct operation of your DAQ card. 

 

Documentation: – Contains a number of files pertaining to the use of DMC/DMA and 

includes example protocols and data files. 

3.3 Starting the 611A DMA Program 

 

To start the 611A program click on the icon labeled DMAv5.1. 

 

When the program starts you may be asked to activate the software before continuing.  

If so then please refer to page 4 of this manual. Once you’ve activated your copy of 611A, 

you will be presented with the main window.  This window can be repositioned, maximized, 

minimized and stretched using the normal Windows controls for manipulating the display 
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window.  The main page provides access to all of the menu items and also contains a large 

graphing area for the display of data recorded during a test in DMC or 600A.  A menu bar is 

located along the top of the screen that includes the following main menu headings.   

 

File High Throughput Help 

 

Clicking on any menu item opens a drop-down menu that lists the commands 

available under the selected heading.  A detailed description of each command is provided in 

the next chapter.   

 

 

Figure 2: 611A Main Window 

Located near the bottom of the main screen are a series of buttons labeled: Open Data 

File, Filter Setup, Normalization, Muscle Analysis, Work Loop, Time Derivative, Line 

Fitting and Export Data.  These buttons are used to open data files, setup the filter 

parameters, apply normalization to the data, open the Analysis window for analysis of the 

data on screen, do work loop analysis, do time-derivative analysis, line-fit the data, and 

produce text output data files, respectively.  Also located at the left of the screen are several 

controls that select what data is displayed in the main graph area to the right.  
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3.4 Using the ASI611A Program – Quick Start Guide 

 

Now that that program is up and running we will go through the main steps required 

to analyze test data, and export the calculated values.  Once you have completed this Quick 

Start Guide you will be familiar with the operation of the program.  More complete details 

about using the program are provided in chapter 4.0.  

 

Quick Start Guide 

1) Turn on the PC, log in, and start the 611A program (section 3.2). 

2) Click the Open Data File button to load a data file recorded previously by DMC or 

600A. 

3) Close the File Information Window 

4) Ensure your data is shown on the graph to the right. 

5) Using the slider controls, position your data within the window such that the signal of 

interest is shown with baseline data on either side. 

6) Click the Filter Setup button. 

7) Use the Cutoff Frequency and Falloff Order controls to adjust the filter to clean up 

the data.  By default, the cutoff frequency is set to 1/3 of your sampling frequency.  

Note:  The filter cutoff must be less than ½ of sampling frequency.  Once you’re 

happy with the settings (and the filtered signal shown in the bottom graph), click Save 

Changes. 

8) Click the Muscle Analysis button. 

9) The Muscle Analysis window shows various statistics about the displayed data, see 

Figure 3.   
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Figure 3: Muscle Analysis Window 

 

10) A checkbox at the top of the Muscle Analysis window allows you to switch between 

statistics generated on the filtered or the unfiltered data. 

11) The different windows of DMA are designed to be able to be left open while using 

other parts of the program. For example, you can adjust the sliders on the main 

window and immediately see the changes in the Muscle Analysis window. 

12) The Muscle Analysis window can be closed by selecting the Close Window button at 

the bottom of the Muscle Analysis window, or by clicking the X in the top right 

corner of the window. 

13) Clicking the Export Data button on the Main Window to open the Export Data 

window, see Figure 4. 
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Figure 4: Export Data Window 

 

14) The Export Data window is used to export the data from the various windows of 

DMA to an ASCII text file, which can be read by many other programs including: 

Excel, MatLab, Maple, SAS, or your favorite statistical analysis program.  To export 

a particular screen, use the pull-down menu to select the data you wish to export, and 

then click the Export button. 

15) You will be asked to provide a file name and path to export the data to.  Select your 

preferred location, and click Save.  The program will export your data to the selected 

file. 

16) The ASI611A program should be closed by clicking on Exit found under the File 

menu. 
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4.0 Main Program 

 

 The ASI611A Dynamic Muscle Analysis program uses a familiar Windows-type 

interface that consists of a main window containing a graphics window, control buttons, 

checkboxes and radio buttons.  The main window can be moved, re-sized, minimized, 

maximized and closed by clicking on the various window controls provided.  In the upper 

right corner of the window are minimize and maximize buttons.  Clicking anywhere on the 

window will bring focus to the window.  The window can be dynamically re-sized by 

clicking on a border or a corner of the window.  Details of the main program window and 

program operation will be presented in the following sections. 

 

4.1 Main Screen 

 The main screen consists of a menu bar at the top, a large graphics window located in 

the centre, a number of control buttons, checkboxes, radio buttons, and sliders (see Figure 5). 

 

 

Figure 5: ASI611A Main Window 
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4.1.1 Graphics Window 

 

 The graphics window is used to plot length, force and stimulation measured from the 

muscle tissue.  The graph consists of time along the x-axis, force on the upper graph, length 

on the centre graph, and stimulus on the lower graph.  The filtered input, unfiltered input, and 

output traces are plotted in different colours.  The appearance of the graph can be changed 

by: dragging the horizontal grey bars between the graphs to resize them, by clicking the 

Show/Hide trace checkboxes, and by using the sliders located below them to pan and zoom 

the window to get a better look at the data.   The program automatically scales the display 

axes to the range of the collected data.   

 

4.1.2 Control Buttons 

 

 The main screen includes eight control buttons.  These buttons are: Open Data File, 

Filter Setup, Normalization, Muscle Analysis, Work Loop, Time Derivative, Line Fitting, 

and Export Data (see Figure 5). 

 

Open Data File Button 

The Open Data File button is used to open a file selection window to choose the data 

file you wish to analyze.  You can open data files from DMCv4.x, DMCv5.x, and 600A v2.x. 

 

Filter Setup Button 

The Filter Setup button is used to open the Filter Setup window.  This window is used 

to set the cutoff frequency and falloff order of the 2-pass Butterworth filter.   

 

Normalization Button 

The Normalization button is used to open the Normalization setup window.  This 

window is used to set the reference values for calculating L/Lref, F/Fref, Stress and Strain.  It 

will be prepopulated with values from the data file if they’re available, otherwise, they can be 

entered here manually. 

 

Muscle Analysis Button 

The Muscle Analysis button is used to open the Muscle Analysis window.  This 

window provides various statistics about the data selected on screen in the main window.   

 

Work Loop Button 

The Work Loop button is used to open the Work Loop window.  This window is used 

on sinusoidal data to calculate a work loop.  It is described in more detail in Chapter 5.0. 

 

Time Derivative Button 

The Time Derivative button is used to open the Time Derivative window.  This 

window is used to calculate rate-of-change data from your test.  It is described in more detail 

in Chapter 6.0. 
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Line Fitting Button 

The Line Fitting button is used to open the Line Fitting window.  This window is 

used to fit a linear or exponential curve to a selected section of your test data.  It is described 

in more detail in Chapter 7.0. 

 

Export Data Button 

The Export Data button is used to open the Export Data window.  This window is 

used to export data from each of the processing windows to a data file.  These data files can 

be read by Excel, MatLab, Maple, SAS, or other statistical analysis software packages. 

 

4.1.3 Checkboxes and Radio Buttons 

 

 Six checkboxes and six radio buttons can be found on the main screen. 

 

The six checkboxes provide the user with the ability to switch on and off the display 

of each trace.  The user may find it easier to see the traces they’re interested in by turning off 

the visibility of the others. 

 

The six radio buttons only become active after the normalization parameters are set 

using the Normalization window.  The radio buttons allow the user to select how to display 

the Force/Position data, as unitized Length, unitized Force, normalized Length, normalized 

Force, Stress, or Strain. 

 

4.2 Main Menu 

 

 The main menu consists of the following three headings which will be described in 

the rest of this chapter.   

 

File High Throughput Help 

 

 

4.2.1 File Menu  
 

The File menu contains commands to open data files, show file information, and exit 

the program.  

 

Open ASI Data File 

Opens a file dialog to select an ASI data file to analyze.  This file can come from 

DMCv4.x, DMCv5.x, or 600Av2.x 

 

Open ASCII Data File (disabled) 

This item is currently disabled and will be added in the future. 
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Show File Info 

Opens the file information window.  This window displays information collected with 

the data including: the data rate, and comments recorded at the time of the test. 

 

Exit 

Closes the ASI611A program. 

 

 

4.2.2 High Throughput Menu 

 

 The High Throughput Menu is unique.  Until the user has licensed their copy of High 

Throughput, the menu will contain only a single item, which allows them to license High 

Throughput.  Once High Throughput has been licensed, the menu contains the following five 

items. 

 

Force-Frequency Analysis 

 Opens the High Throughput window in Force-Frequency analysis mode. 

 

Force-Time Analysis 

 Opens the High Throughput window in Force-Time analysis mode. 

 

Position-Time Analysis 

 Opens the High Throughput window in Position-Time analysis mode. 

 

Fatigue Analysis 

 Opens the High Throughput window in Fatigue analysis mode. 

  

About DMA-HT 

 Provides information about the ASI612A module including contact information for 

Aurora Scientific Inc. and the program version number. 

 

 

4.2.3 Help Menu  
 

The Help menu contains two commands: Topics and About. 

 

Topics 

Opens the 611A help file.  Links are included in the document. 

 

About 

 Provides information about the ASI611A program including contact information for 

Aurora Scientific Inc. and the program version number. 
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5.0 Work Loop Analysis 

 

 The Work Loop window provides an interface for instantly calculating work loop 

data from sinusoidal tests.  The Work Loop window populates its topmost graph with the 

currently loaded test data from the main window.  Using the cursors on the graph, and the 

pull down menus below the graph, the user can select what portion of the test data to use to 

create the work loop graph.  The work loop graph updates instantly when the cursors are 

moved.   

 

 

Figure 6: Work Loop Window 

 

5.1 Calculating Work Loops 

 

1) Start the ASI 611A program. 

2) Load a data file, and click on the Work Loop button. 

3) The Work Loop window will open and data will be preloaded on the screen. 

4) Set the three cursors to enclose your data of interest.  Blue is the start cursor, Yellow 

is the mid cursor, and White is the end cursor. 

5) Notice that the Work Loop graph on the bottom right updates as you drag the cursors 

around, and the calculated numbers shown on the left side of the window are updated 

to reflect your selection. 
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6) To export work loop data first close the Work Loop window and then click Export 

Data.  The calculated work loop data will be stored in the text file. 
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6.0 Time Derivative Window 

 

 The Time Derivative window is used to calculate the first derivative of the Position 

and Force signals.  Using the cursors in the data, and the controls at the left, the user can 

control what data the derivative is being calculated on, as well as what type of derivative.  

Setting the segment length to a non-zero number and using a linear fit in segments may aid in 

getting a cleaner derivative signal given noisy input data.   

 

 

Figure 7: Time Derivative Window 

 

6.1 Calculating Time Derivatives 

 

1) Start the ASI 611A program. 

2) Load a data file, and click on the Time Derivative button. 

3) The Time Derivative window will open and data will be preloaded on the screen. 

4) Set the three cursors to enclose your data of interest.  Blue is the start cursor, Yellow 

is the mid cursor, and White is the end cursor. 

5) Notice that the Time Derivative graph on the bottom right updates as you drag the 

cursors around, and as you change the controls at the left. 

6) Closing the window and clicking Export Data will allow you to Export all of the data 

values from this window to a text file. 
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7.0 Line Fitting Window 

 

 The Line Fitting window is used to fit a linear or exponential fit to the Force or 

Position traces.  Using the cursors in the data, and the controls at the bottom, the user can 

control what data the fit is being calculated on, as well as the type of fit.  Position traces can 

only be fitted with a linear fit. 

 

 

Figure 8: Line Fitting Window 

 

7.1 Calculating Line Fitting  

 

1) Start the ASI 611A program. 

2) Load a data file, and click on the Line Fitting button. 

3) The Line Fitting window will open and data will be preloaded on the screen. 

4) Set the two cursors at the points you wish the fit to start and end.  Blue is the start 

cursor, Yellow is the end cursor. 

5) Notice that the green fit trace on the graph updates as you drag the cursors around, 

and change the controls at the bottom. 

6) Closing the window and clicking Export Data will allow you to Export the fit data 

from this window to a text file. 
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8.0 High Throughput Module – 612A 

 

 The High Throughput module is used to analyze a large number of data files at one 

time.  High Throughput automatically place cursors in your data files, calculates muscle 

analysis data for a list of files and displays the results in a tabular format.  Each file’s cursors 

can be manually adjusted afterwards, or the user can optionally disable automatic cursor 

placement instead opting to manually set the cursors for all data files in the experiment. 

 

 

Figure 9: High Throughput Window 

 

8.1 Using High Throughput 

 

1) Start the ASI 611A program. 

2) Use the High Throughput menu to select the appropriate high throughput module for 

your analysis. 

3) The High Throughput window will open. 

4) Click the Pick Files button, and select all of the data files you wish to analyze.  You 

can use your mouse to click and drag over a group of files, or you can hold the Ctrl 

button on your keyboard while clicking individual files to build your selection.  Click 

Open when you’ve selected all of the desired files. 

5) You will notice the table will populate with your data files.  You may need to use the 

scroll bars to see all of the files you have selected. 

6) Select your cursor placement method.  Automatic will attempt to place the cursors 

within your file so as to enclose your data, while Manual will enable the two Cursor 

boxes to the right.  Entering a timestamp in those boxes will fix the cursors in all files 

to that specified start and end times. 

7) Click Analyze. 

8) You will see the progress bar at the bottom advance as each file is analyzed, and once 

complete, you will see that the table has populated itself with the calculated numbers 
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for each file you selected.  If the automatic cursor placement fails, or your manual 

placement is invalid, the line will turn red to show the error, and not calculate data. 

9) You can edit the cursor locations in a single file, or simply view a single file’s traces 

by double clicking on its row in the table. 

10) Using the Plot spin control at the bottom of the screen, you can select a field from the 

table, and click the plot button to plot a graph of the table in terms of that field vs row 

number. 

11) You can use the button labeled Export Table to Excel to open an Excel window 

which will be pre-populated with all of the data from the table.  Note: this function 

only works if you have Microsoft Excel on your PC. 

12) If you do not have Excel, you can use the button labeled Save Table to ASCII to save 

the table to an ASCII text file.  This file can then be imported into statistical analysis 

programs such as Maple, MatLab, etc. 
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9.0 Installation of a New Version of the ASI611A Program 

 

 This chapter provides a brief description of the procedure required to update to a 

newer version of the 611A program.   

 

Aurora Scientific Inc. is striving to make 611A the best program for the analysis of 

muscle mechanics experiments.  We are pleased to receive user comments about the program 

including suggestions for new functions.  

 

New versions of 611A are available from our website at  

http://www.aurorascientific.com/update/.   

 

Once you have received a new version of the program please follow the procedure listed 

below to update your program.  

 

1. Close all open programs. 

2. Copy the supplied update file to the PC to be updated 

3. Run the setup.exe file found in the update package.   

4. Follow the on-screen directions to complete the installation process. 

5. You may be asked to reboot the computer upon completion.  Do so if requested. 

 

This completes the update procedure.  In order to check that the update has been 

installed correctly start the program and click on Help->About.  Compare the version number 

listed on the About screen with that shown in the update file name.  If they are the same then 

you have successfully updated to the latest program version.  If you experience any 

difficulties while updating your system please contact Aurora Scientific Inc. 

 

 

 

 

http://www.aurorascientific.com/update/
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10.0 Technical Support, Warranty and Repairs 

 

Aurora Scientific Inc. is dedicated to providing you with products that allow you to 

meet your research goals.  For this reason technical assistance is always free and will be 

available for the life of your product.  If you do have a problem with a product then please know 

that all ASI products are covered by a three year warranty covering both parts and labour.  If 

you need to return a product to us for repair then consult the final section of this chapter for 

returns information. 

 

10.1 Technical Support  

 

 Please don’t hesitate to contact us if you have any technical support issues.  Contact us 

by telephone, email, fax, or regular mail.   

 

 Address: Aurora Scientific Inc. 

   Technical Support 

   P.O. Box 2724 

   Richmond Hill, Ontario, CANADA 

   L4E 1A7 

 

 Phone:  1 905 727-5161 

 Toll Free: 1 877 878-4784 (North America) 

 FAX:  1 905 713-6882 

 E-mail:  TechSupport@AuroraScientific.com 

 Web site: www.AuroraScientific.com 

 

10.2 Warranty 

 

 Products manufactured by Aurora Scientific Inc. (ASI) are guaranteed to the original 

purchaser for a period of three (3) years.  Under this warranty, the liability of ASI is limited to 

servicing, adjusting and replacing any defective parts that are of ASI manufacture.  ASI is not 

liable to the customer for consequential or other damages, labour losses or expenses in 

connection with or by reason of the use or inability to use the products manufactured by ASI.   

 

 Guarantee of parts and components not manufactured by ASI shall be the same as the 

guarantee extended by the manufacturer of such components or parts.  Where possible such 

parts returned to ASI will be sent to the manufacturer for credit or replacement.  Ultimate 

disposition of these items will depend upon the manufacturer's decision.   

 

 All shortages must be reported within ten (10) days after receipt of shipment. 

 

 Except where deviations are specified in literature describing particular products, the 

limited warranty above is applicable to all ASI products, provided the products are returned to 

ASI and are demonstrated to the satisfaction of ASI to be defective. 

 

mailto:TechSupport@AuroraScientific.com
http://www.aurorascientific.com/
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 Transportation costs of all products returned to ASI must be borne by the customer and 

products must be returned to ASI within three years after delivery to the original purchaser.  ASI 

cannot assume responsibility for repairs or changes not authorized by ASI or damage resulting 

from abnormal or misuse or lack of proper maintenance. 

 

 Repair or service work not covered under the limited warranty will be billed at current 

service rates.   

 

NO EXPRESS WARRANTIES AND NO IMPLIED WARRANTIES WHETHER FOR 

MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR USE, OR OTHERWISE 

OTHER THAN THOSE EXPRESSLY SET FORTH ABOVE WHICH ARE MADE 

EXPRESSLY IN LIEU OF ALL OTHER WARRANTIES, SHALL APPLY TO PRODUCTS 

SOLD BY ASI, AND NO WAIVER, ALTERATION OR MODIFICATION OF THE 

FOREGOING CONDITIONS SHALL BE VALID UNLESS MADE IN WRITING AND 

SIGNED BY AN EXECUTIVE OFFICER OF ASI. 

 

10.3 Returning Products to Aurora Scientific Inc. for Repair  

 

There are a few simple steps that must be completed before returning your product to 

Aurora Scientific Inc. 

 

1. Obtain a Return Material Authorization number (RMA#). 

Contact our technical support department to obtain a RMA #.  We require the serial 

number of the product along with your contact information, i.e. your name, institution, 

phone number and email address. 

 

2. Package your instrument. 

Use the original packaging materials if available. If you do not have original packaging 

then ensure that the product is wrapped in bubble pack and placed in a sturdy corrugated 

cardboard box. If you are returning a force transducer please place the transducer head in 

the plastic protective box and then wrap the plastic box in bubble pack and place it in a 

small cardboard box which can then be placed in the larger box along with the 

electronics. For force transducer repairs we require both the transducer head and the 

control electronics. Please don't send the power cord. When returning a muscle lever 

system wrap the motor in bubble pack and place it along with the lever arm in a small 

cardboard box and then place that box in the larger shipping container along with the 

controller. For muscle lever repairs we require the motor, lever arm, motor cable and 

control electronics. Please don't send the power cord. 

 

3. Prepare Customs documents. 

Canadian Clients: no customs documents are required, skip to step 4. 

European Clients: no customs documents are required, skip to step 4 and ship 

to Aurora Scientific Europe. 

USA and Rest of the World Clients: You must include a Commercial Invoice (CI) 

with the shipment. Please click this link to download a blank CI. 

You can also prepare the commercial invoice yourself instead of using the downloadable 

form. Print the document on your company's letterhead and include the following 

http://www.aurorascientific.com/contact/
http://aurorascientific.web9.hubspot.com/Default.aspx?app=LeadgenDownload&shortpath=docs%2fCCI.pdf
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information: Date, Shipper's Name, Address and Phone Number (your company 

information), Consignee's Name, Address and Phone Number (Aurora Scientific Inc. is 

the Consignee), Country of Origin of Goods (this will be Canada if you purchased the 

instrument from Aurora Scientific or USA if your product was purchased from 

Cambridge Technology), Conditions of Sale (include the following statement: GOODS 

RETURNING TO FACTORY FOR REPAIR, TEMPORARY IMPORT), Number of 

Packages (normally 1), Description of Goods (e.g. Model 300B Muscle Lever System, 

Serial Number 1111), Quantity of Each Item (normally 1) and Value for Customs 

Purposes (the original purchase price of the instrument). 

Place three (3) copies of your CI in an envelope and mark the outside CUSTOMS 

PAPERS ENCLOSED. Attach the envelope to the outside of the box. 

 

4. Choose a shipper and prepare the waybill. 

European Clients: ship your instrument to Aurora Scientific Europe in Dublin, Ireland. 

All other Clients: ship your instrument to Aurora Scientific Inc. in Aurora, ON, 

Canada. 

You may ship your instrument back to us via the courier of your choice or via parcel 

post. If possible we prefer that you ship via FedEx. You are responsible for both the 

shipping and brokerage charges so please mark the waybill accordingly. Please don't 

ship freight collect. Shipments sent freight collect will be received but you will be 

invoiced for the shipping charges when your instrument is returned. 

 

5. Prepare and send a purchase order. 

After we receive the instrument we will evaluate it and contact you with the estimated 

repair cost. We require a purchase order before we can repair and return your 

instrument. Please fax or email us the purchase order at your earliest convenience. 

 

Return Shipping Address: 

 

 

Canada, USA, Asia 

 

 

Europe 

 

Aurora Scientific Inc. 

360 Industrial Parkway S., Unit 4 

Aurora, Ontario, CANADA  

L4G 3V7  

Attn: RMA Returns 

Tel: +1-905-727-5161 

 

 

Aurora Scientific Europe 

Hilton House 

3 Ardee Road 

Rathmines, Dublin 6, Ireland 

Attn: RMA Returns 

Tel: +353-1-525-3300 

 

 

  

http://www.aurorascientific.com/contact/
http://www.aurorascientific.com/contact/
http://www.aurorascientific.com/contact/
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Appendix A - 611A File Structures  

 

Muscle Analysis Data File Structure 

 
DMAv5.0 Muscle Analysis Data File 

Source Data File: C:\Documents and Settings\ASI\Desktop\dcmsin1.dat 

Filtered Data?: N 

Start Sample: 0 

End Sample: 10000 

Data: 

Force 1/2 Relaxation Time: 2.000000E-2 sec 

Force Integration: 1.855068E+0 g-sec 

Force Total Time: 1.000000E+0 sec 

Force Maximum: 1.190900E+1 g 

Force Time to Maximum: 2.691000E-1 sec 

Force Minimum: 2.023875E-1 g 

Force Time to Minimum: 3.472000E-1 sec 

Force Max Derivative: 5.280370E+3 g/sec 

Force Time to Max Derivative: 0.000000E+0 sec 

Force Min Derivative: -6.299924E+3 g/sec 

Force Time to Min Derivative: 9.999000E-1 sec 

Force Baseline: 1.045422E+0 g 

Position 1/2 Relaxation Time: 3.310000E-2 sec 

Position Integration: 3.245193E-3 mm-sec 

Position Total Time: 1.000000E+0 sec 

Position Maximum: 5.049133E-1 mm 

Position Time to Maximum: 4.584000E-1 sec 

Position Minimum: -4.977417E-1 mm 

Position Time to Minimum: 5.579000E-1 sec 

Position Max Derivative: 4.653931E+1 mm/sec 

Position Time to Max Derivative: 4.013000E-1 sec 

Position Min Derivative: -4.806519E+1 mm/sec 

Position Time to Min Derivative: 5.053000E-1 sec 

Position Baseline: 3.967285E-3 mm 
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Work Loop File Structure 
 

DMAv5.0 Work Loop Data File 

Source Data File: C:\Documents and Settings\ASI\Desktop\dcmsin1.dat 

Cursor 1 Index: 2.074000E+3 

Cursor 2 Index: 3.951000E+3 

Cursor 3 Index: 5.963000E+3 

Top Loop Integral (1-2): 3.191071E+0 

Bottom Loop Integral (1-2): 2.291138E+0 

Loop Integral (1-2): 8.999330E-1 

Norm. Viscosity Index (1-2): 2.820160E+1 

Top Loop Integral (2-3): 2.609667E+0 

Bottom Loop Integral (2-3): 1.612270E+0 

Loop Integral (2-3): 9.973971E-1 

Norm. Viscosity Index (2-3): 3.821933E+1 

Top Loop Integral (Difference): -6.123944E-1 

Bottom Loop Integral (Difference): -6.149121E-1 

Loop Integral (Difference): 2.517745E-3 

Norm. Viscosity Index (Difference): -4.111312E-1 

Start Cursor Position X: 1.921772E-3 

Start Cursor Position Y: 8.699905E-1 

End Cursor Position X: 4.956930E-1 

End Cursor Position Y: 6.268855E+0 

Offset/Amplitude: 7.119231E-1 

Slope/Rate: 4.338897E+0 

Mean Squared Error: 4.044522E-3 

R-squared: 9.969249E-1 

Correlation R: 9.984613E-1 

Exp-Offset: 0.000000E+0 

 

Time Derivative File Structure 

 
DMAv5.0 Time Derivative Data File 

Source Data File: C:\Documents and Settings\ASI\Desktop\dcmsin1.dat 

Cursor 1 Index: 2.000000E+3 

Cursor 2 Index: 4.000000E+3 

Cursor 3 Index: 6.000000E+3 

Segment Length: 0.000000E+0 

R-sq Threshold: 9.800000E-1 

Cursor Position X: 2.952000E-1 

Cursor Position Y: -6.026811E+2 

Derivative Type: Numerical Derivative 

Time Derivative: 

Time Rate of Change 

0.200000 -86.242633 

0.200100 94.627664 

0.200200 87.799456 

0.200300 -174.977359 

0.200400 -159.319234 

0.200500 123.520838 

0.200600 129.751522 

0.200700 -44.558292 

0.200800 -30.840407 

0.200900 -2.748792 

0.201000 -61.224085 
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Line Fit File Structure 

 
DMAv5.1 Line Fitting Data File 

Source Data File: C:\Users\ASI\Desktop\test.dat 

Start Cursor Index: 3.621000E+3 

End Cursor Index: 4.510000E+3 

Fit Channel: Force 

Fit Type: Exponential 

Offset/Amplitude: 5.301594E-8 

Slope/Rate: 4.265648E+1 

MSE: 1.415042E+0Line Fit: 

28.803840 

28.595227 

28.388124 

28.182521 

27.978407 

27.775771 

27.574603 

27.374892 

27.176628 

26.979799 

26.784396 

26.590408 

26.397825 

26.206637 

26.016834 

25.828405 

25.641341 

25.455632 

25.271268 

25.088239 

24.906536 

24.726148 

24.547068 

24.369284 

24.192787 

24.017570 

23.843621 

23.670932 

23.499493 

23.329296 

23.160332 

22.992592 

22.826067 

22.660747 

22.496625 

22.333692 

22.171939 

22.011357 

21.851938 

21.693674 

21.536556 

21.380576 

21.225726 

21.071997 

20.919381 

20.767871 

20.617459 


